
Multivariate Two-Way RM ANOVA, 1 

Multivariate Two-Way Repeated Measures ANOVA 
Maxwell & Delaney 

 
Both Factors Repeated 
 
A Factor: Phase 
B Factor: Time 
Dependent Variable: % of positive drug screens 
 
 

 Phase I Phase II Phase III 
Subject Day Night Day Night Day Night 

S1 30 40 10 20 10 10 
S2 30 40 20 20 20 40 
S3 40 30 20 30 30 20 
S4 50 40 40 50 40 40 
S5 10 20 10 30 10 20 
S6 30 40 10 20 10 10 
S7 30 40 20 20 20 40 
S8 40 30 20 30 30 20 
S9 50 40 40 50 40 40 
S10 10 20 10 30 10 20 

 
 



Multivariate Two-Way RM ANOVA, 2 

Test of A Factor: Phase 
 
Null Hypothesis: 
 
 
Alternative Hypothesis:  
 
 
Testing the A Factor 
• Calculate the average score of each person for every level of the A factor.  
• Create a – 1 difference variables to represent the A factor. 
 

 Phase I Phase II Phase III 
S1 35 15 10 
S2 35 20 30 
S3 35 25 25 
S4 45 45 40 
S5 15 20 15 
S6 35 15 10 
S7 35 20 30 
S8 35 25 25 
S9 45 45 40 
S10 15 20 15 

 
Reduced Model 

 
 

D1 = P2 – P1 

 
Predicted 

D1 

 
Squared Errors 

for D1 

 
 

D2 = P3 – P2 

 
Predicted 

D2 

 
Squared Errors 

for D2 

Errors for D1 * 
Errors for D2 

-20  (-20 – 0)2 = 400 -5  (-5 – 0)2 = 25 (-20)(-5) = 100  
-15  (-15 – 0)2 = 225 10  (10 – 0)2 = 100 (-15)(10) = -150 
-10  (-10 – 0)2 = 100 0  (0 – 0)2 = 0 (-10)(0) = 0 
0  (0 – 0)2 = 0 -5  (-5 – 0)2 = 25  (0)(-5) = 0 
5  (5 – 0)2 = 25 -5  (-5 – 0)2 = 25 (5)(-5) = -25 

-20  (-20 – 0)2 = 400  -5  (-5 – 0)2 = 25 (-20)(-5) = 100 
-15  (-15 – 0)2 = 225 10  (10 – 0)2 = 100 (-15)(10) = -150 
-10  (-10 – 0)2 = 100 0  (0 – 0)2 = 0 (-10)(0) = 0 
0  (0 – 0)2 = 0 -5  (-5 – 0)2 = 25 (0)(-5) = 0 
5  (5 – 0)2 = 25 -5  (-5 – 0)2 = 25 (5)(-5) = -25 

Mean = -8  ER(D1) = 1500 Mean = -1   ER (D2) = 350 ER(D1D2) = -150 
 

Full Model 
 
 

D1 = P2 – P1 

 
Predicted 

D1 

 
Squared Errors 

for D1 

 
 

D2 = P3 – P2 

 
Predicted 

D2 

 
Squared Errors 

for D2 

Errors for D1 * 
Errors for D2 

-20  (-20+8)2 = 144 -5  (-5+1)2 = 16 (-12)(-4) = 48  
-15  (-15+8)2 = 49 10  (10+1)2 = 121 (-7)(11) = -77 
-10  (-10+8)2 = 4 0  (0+1)2 = 1 (-2)(1) = -2 
0  (0+8)2 = 64 -5  (-5+1)2 =16  (8)(-4) = -32 
5  (5+8)2 = 169 -5  (-5+1)2 = 16 (13)(-4) = -52 

-20  (-20+8)2 = 144 -5  (-5+1)2 = 16 (-12)(-4) = 48 
-15  (-15+8)2 = 49 10  (10+1)2 = 121 (-7)(11) = -77 
-10  (-10+8)2 = 4 0  (0+1)2 = 1 (-2)(1) = -2 
0  (0+8)2 = 64 -5  (-5+1)2 = 16  (8)(-4) = -32 
5  (5+8)2 = 169 -5  (-5+1)2 = 16 (13)(-4) = -52 

Mean = -8  EF(D1) = 860 Mean = -1  EF (D2) = 340 EF(D1D2) = -230 
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dfnumerator = a – 1  
dfdenominator = n – a + 1 
FCrit =  
 
Interpretation: 
 



Multivariate Two-Way RM ANOVA, 4 

Test of B Factor: TIME 
 
Null Hypothesis: 
 
 
Alternative Hypothesis:  
 
 
Testing the B Factor 
• Calculate the average score of each person for every level of the B factor.  
• Create b – 1 difference variables to represent the B factor. 
 

 Day Night 
S1 16.6667 23.3333 
S2 23.3333 33.3333 
S3 30 26.6667 
S4 43.3333 43.3333 
S5 10 23.3333 
S6 16.6667 23.3333 
S7 23.3333 33.3333 
S8 30 26.6667 
S9 43.3333 43.3333 
S10 10 23.3333 

 
Reduced Model 

 
D1 = Night - Day 

 
Predicted D1 

 
Squared Errors for D1 

6.6667  (6.6667 – 0)2 = 44.4444 
10  (10 – 0)2 = 100 

-3.3333  (-3.3333 – 0)2 =11.1111  
0  (0 – 0)2 = 0 

13.3333  (13.3333 – 0)2 = 177.7778  
6.6667  (6.6667 – 0)2 = 44.4444  

10  (10 – 0)2 = 100 
-3.3333  (-3.3333 – 0)2 =11.1111  

0  (0 – 0)2 = 0 
13.3333  (13.3333 – 0)2 = 177.7778  

Mean = 5.3333  ER(D1) = 666.6667
 

Full Model 
 

D1 = Night - Day 
 

Predicted D1 
 

Squared Errors for D1 
6.6667  (6.6667-5.3333)2 =1.7779  

10  (10-5.3333)2 = 21.7781  
-3.3333  (-3.3333-5.3333)2 = 75.1105  

0  (0-5.3333)2 = 28.4441  
13.3333  (13.3333-5.3333)2 = 64  
6.6667  (6.6667-5.3333)2 =1.7779  

10  (10-5.3333)2 = 21.7781  
-3.3333  (-3.3333-5.3333)2 = 75.1105  

0  (0-5.3333)2 = 28.4441  
13.3333  (13.3333-5.3333)2 = 64  

Mean = 5.3333  EF(D1) = 382.2222
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Interpretation: 
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Test of AB Interaction: Phase*Time 
 
Null Hypothesis: 
 
 
Alternative Hypothesis:  
 
 
Testing the AB Interaction 
• Calculate a difference score to represent the B Effect for each person within each level of A.  
• Create a – 1 difference variables to determine whether the B effect varies across the levels of 

the A factor. 
 

 Phase I 
Night - Day 

Phase II 
Night - Day 

Phase III 
Night - Day 

S1 40 – 30 = 10 20 – 10 = 10 10 – 10 = 0 
S2 40 – 30 = 10 20 – 20 = 0 40 – 20 = 20 
S3 30 – 40 = -10 30 – 20 = 10 20 – 30 = -10 
S4 40 – 50 = -10 50 – 40 = 10 40 – 40 = 0 
S5 20 – 10 = 10 30 – 10 = 20 20 – 10 = 10 
S6 40 – 30 = 10 20 – 10 = 10 10 – 10 = 0 
S7 40 – 30 = 10 20 – 20 = 0 40 – 20 = 20 
S8 30 – 40 = -10 30 – 20 = 10 20 – 30 = -10 
S9 40 – 50 = -10 50 – 40 = 10 40 – 40 = 0 
S10 20 – 10 = 10 30 – 10 = 20 20 – 10 = 10 

 
Reduced Model 

 
 

D1 = P2 – P1 

 
Predicted 

D1 

 
Squared Errors 

for D1 

 
 

D2 = P3 – P2 

 
Predicted 

D2 

 
Squared Errors 

for D2 

Errors for D1 * 
Errors for D2 

10 – 10 = 0  (0 – 0)2 = 0 0 – 10 = -10  (-10 – 0)2 = 100  (0)(-10) = 0  
0 – 10 = -10  (-10 – 0)2 =100  20 – 0 = 20  (20 – 0)2 = 400 (-10)(20) = -200 
10 - -10 = 20  (20 – 0)2 = 400 -10 -10 = -20  (-20 – 0)2 = 400 (20)(-20) = -400 
10 - -10 = 20  (20 – 0)2 = 400 0 – 10 = -10  (-10 – 0)2 =  100 (20)(-10) = -200 
20 – 10 = 10  (10 – 0)2 = 100 10 – 20 = -10  (-10 – 0)2 = 100 (10)(-10) = -100 
10 – 10 = 0  (0 – 0)2 =  0 0 – 10 = -10  (-10 – 0)2 = 100 (0)(-10) = 0 
0 – 10 = -10  (-10 – 0)2 =100  20 – 0 = 20  (20 – 0)2 = 400 (-10)(20) =-200  
10 - -10 = 20  (20 – 0)2 = 400 -10 – 10 = -20  (-20 – 0)2 = 400 (20)(-20) = -400 
10 - -10 = 20  (20 – 0)2 = 400 0 – 10 = -10  (-10 – 0)2 = 100 (20)(-10) = -200 
20 – 10 = 10  (10 – 0)2 = 100 10 – 20 = -10  (-10 – 0)2 = 100 (10)(-10) = -100 

Mean = 8  ER(D1) = 2000 Mean = -6  ER (D2) = 2200 ER(D1D2) = -1800 
 

Full Model 
 
 

D1 = P2 – P1 

 
Predicted 

D1 

 
Squared Errors 

for D1 

 
 

D2 = P3 – P2 

 
Predicted 

D2 

 
Squared Errors 

for D2 

Errors for D1 * 
Errors for D2 

10 – 10 = 0  (0 – 8)2 =64  0 – 10 = -10  (-10+6)2 = 16 (-8)(-4) = 32  
0 – 10 = -10  (-10 – 8)2 = 324  20 – 0 = 20  (20+6)2 = 676 (-18)(26) = -468 
10 - -10 = 20  (20 – 8)2 = 144 -10 -10 = -20  (-20+6)2 = 196 (12)(-14) = -168 
10 - -10 = 20  (20 – 8)2 = 144 0 – 10 = -10  (-10+6)2 = 16 (12)(-4) = -48 
20 – 10 = 10  (10 – 8)2 = 4 10 – 20 = -10  (-10+6)2 = 16 (2)(-4) = -8 
10 – 10 = 0  (0 – 8)2 = 64 0 – 10 = -10  (-10+6)2 = 16 (-8)(-4) = 32  
0 – 10 = -10  (-10 – 8)2 =324  20 – 0 = 20  (20+6)2 = 676 (-18)(26) = -468  
10 - -10 = 20  (20 – 8)2 = 144 -10 – 10 = -20  (-20+6)2 = 196 (12)(-14) = -168  
10 - -10 = 20  (20 – 8)2 = 144 0 – 10 = -10  (-10+6)2 =  16 (12)(-4) = -48 
20 – 10 = 10  (10 – 8)2 = 4 10 – 20 = -10  (-10+6)2 = 16 (2)(-4) =-8  

Mean = 8  EF(D1) = 1360 Mean = -6  EF (D2) = 1840 EF(D1D2) = -1320 
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: Phase 
             Number of Levels: 3 
              √ ADD 
             Within-Subject Factor Name: Time 
             Number of Levels: 2 
              √ ADD 
              √ Define 
              Within-Subjects Variables (PHASE, TIME): 
                         P1DAY(1,1) 
                         P1NIGHT(1,2) 
                         P2DAY(2,1) 
                         P2NIGHT(2,2) 
                         P3DAY(3,1) 
                         P3NIGHT(3,2) 
                √Options 
                         Display Means for: PHASE, TIME, PHASE*TIME 
                         √Estimates of Effect Size 
 
General Linear Model 

Within-Subjects Factors
Measure:MEASURE_1 
PHASE TIME Dependent Variable 

 

1 1 P1DAY 
2 P1NIGHT 

2 1 P2DAY 
2 P2NIGHT 

3 1 P3DAY 
2 P3NIGHT 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

PHASE Pillai's Trace .523 4.392a 2.000 8.000 .052 .523
Wilks' Lambda .477 4.392a 2.000 8.000 .052 .523
Hotelling's Trace 1.098 4.392a 2.000 8.000 .052 .523
Roy's Largest Root 1.098 4.392a 2.000 8.000 .052 .523

TIME Pillai's Trace .427 6.698a 1.000 9.000 .029 .427
Wilks' Lambda .573 6.698a 1.000 9.000 .029 .427
Hotelling's Trace .744 6.698a 1.000 9.000 .029 .427
Roy's Largest Root .744 6.698a 1.000 9.000 .029 .427

PHASE * TIME Pillai's Trace .345 2.105a 2.000 8.000 .184 .345
Wilks' Lambda .655 2.105a 2.000 8.000 .184 .345
Hotelling's Trace .526 2.105a 2.000 8.000 .184 .345
Roy's Largest Root .526 2.105a 2.000 8.000 .184 .345

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: PHASE + TIME + PHASE * TIME 

 
 



Multivariate Two-Way RM ANOVA, 9 

Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects Effect 

Mauchly's 
W 

Approx. 
Chi-Square df Sig. 

Epsilona 
Greenhouse-

Geisser 
Huynh-
Feldt 

Lower-
bound 

dimension1 

PHASE .764 2.157 2 .340 .809 .960 .500
TIME 1.000 .000 0 . 1.000 1.000 1.000
PHASE * 
TIME 

.645 3.507 2 .173 .738 .848 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables 
is proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed 
in the Tests of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: PHASE + TIME + PHASE * TIME 

 
Tests of Within-Subjects Effects

Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Sphericity Assumed 973.333 2 486.667 6.773 .006 .429
Greenhouse-Geisser 973.333 1.618 601.700 6.773 .011 .429
Huynh-Feldt 973.333 1.920 506.864 6.773 .007 .429
Lower-bound 973.333 1.000 973.333 6.773 .029 .429

Error(PHASE) Sphericity Assumed 1293.333 18 71.852    
Greenhouse-Geisser 1293.333 14.559 88.835    
Huynh-Feldt 1293.333 17.283 74.834    
Lower-bound 1293.333 9.000 143.704    

TIME Sphericity Assumed 426.667 1 426.667 6.698 .029 .427
Greenhouse-Geisser 426.667 1.000 426.667 6.698 .029 .427
Huynh-Feldt 426.667 1.000 426.667 6.698 .029 .427
Lower-bound 426.667 1.000 426.667 6.698 .029 .427

Error(TIME) Sphericity Assumed 573.333 9 63.704    
Greenhouse-Geisser 573.333 9.000 63.704    
Huynh-Feldt 573.333 9.000 63.704    
Lower-bound 573.333 9.000 63.704    

PHASE * TIME Sphericity Assumed 173.333 2 86.667 2.489 .111 .217
Greenhouse-Geisser 173.333 1.476 117.426 2.489 .130 .217
Huynh-Feldt 173.333 1.696 102.197 2.489 .122 .217
Lower-bound 173.333 1.000 173.333 2.489 .149 .217

Error(PHASE*TIME) Sphericity Assumed 626.667 18 34.815    
Greenhouse-Geisser 626.667 13.285 47.171    
Huynh-Feldt 626.667 15.265 41.053    
Lower-bound 626.667 9.000 69.630    

 
  



Multivariate Two-Way RM ANOVA, 10 

 
Tests of Within-Subjects Contrasts

Measure:MEASURE_1 
Source    TIME Type III 

Sum of 
Squares df 

Mean 
Square F Sig. 

Partial Eta 
Squared 

PHASE  Linear   810.000 1 810.000 9.851 .012 .523
 Quadratic   163.333 1 163.333 2.657 .138 .228

Error(PHASE)  Linear   740.000 9 82.222    
 Quadratic   553.333 9 61.481    

TIME   dimension3 Linear 426.667 1 426.667 6.698 .029 .427
Error(TIME)   dimension3 Linear 573.333 9 63.704    
PHASE * TIME  Linear  Linear 10.000 1 10.000 .643 .443 .067

 Quadratic  Linear 163.333 1 163.333 3.021 .116 .251
Error(PHASE*TIME)  Linear  Linear 140.000 9 15.556    

 Quadratic  Linear 486.667 9 54.074    
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 44826.667 1 44826.667 79.003 .000 .898
Error 5106.667 9 567.407    

 
Estimated Marginal Means 
 

1. PHASE
Measure:MEASURE_1 
PHASE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 
1 33.000 3.266 25.612 40.388
2 25.000 3.496 17.091 32.909
3 24.000 3.559 15.949 32.051

 
2. TIME 

Measure:MEASURE_1 
TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 24.667 3.823 16.018 33.315
2 30.000 2.534 24.268 35.732

 
3. PHASE * TIME

Measure:MEASURE_1 
PHASE TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 

1 1 32.000 4.422 21.996 42.004
2 34.000 2.667 27.968 40.032

2 1 20.000 3.651 11.740 28.260
2 30.000 3.651 21.740 38.260

3 1 22.000 3.887 13.206 30.794
2 26.000 4.000 16.951 35.049

 
  



Multivariate Two-Way RM ANOVA, 11 

 
Follow-up Tests When the interaction was not significant… 
 
Pairwise Comparisons Among the Levels of A Factor. 

• For each level of A, create a new variable in SPSS that is the average. 
• Use the t test for dependent samples to conduct the pairwise comparisons.  
• Use a Bonferroni adjusted alpha level to determine the significance of the t tests. 

 
 
 

SPSS Instructions 
→Transform→Compute Variable 
     Target Variable: PHASE1 
     Numeric Expression: MEAN(P1DAY,P1NIGHT) 
→Transform→Compute Variable 
     Target Variable: PHASE2 
     Numeric Expression: MEAN(P2DAY,P2NIGHT) 
→Transform→Compute Variable 
     Target Variable: PHASE3 
     Numeric Expression: MEAN(P3DAY,P3NIGHT) 
 
 
 
Pairwise Comparisons Among the Levels of B Factor. 

• For each level of B, create a new variable in SPSS that is the average. 
• Use the t test for dependent samples to conduct the pairwise comparisons.  
• Use a Bonferroni adjusted alpha level to determine the significance of the t tests. 

 
Since B only has 2 levels, pairwise comparisons are unnecessary.  
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SPSS Instructions 
→ Analyze →Compare Means →Paired Samples T Test 
           Paired Variables: 
               Pair 1: PHASE1   PHASE2 
               Pair 2: PHASE1   PHASE3 
               Pair 3: PHASE2   PHASE3  
 

T-Test 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paired Samples Statistics

33.0000 10 10.32796 3.26599
25.0000 10 11.05542 3.49603
33.0000 10 10.32796 3.26599
24.0000 10 11.25463 3.55903
25.0000 10 11.05542 3.49603
24.0000 10 11.25463 3.55903

PHASE1
PHASE2

Pair
1

PHASE1
PHASE3

Pair
2

PHASE2
PHASE3

Pair
3

Mean N Std. Deviation
Std. Error

Mean

Paired Samples Correlations

10 .584 .076
10 .650 .042
10 .848 .002

PHASE1 & PHASE2Pair 1
PHASE1 & PHASE3Pair 2
PHASE2 & PHASE3Pair 3

N Correlation Sig.

Paired Samples Test

8.0000 9.77525 3.09121 1.0072 14.9928 2.588 9 .029
9.0000 9.06765 2.86744 2.5134 15.4866 3.139 9 .012
1.0000 6.14636 1.94365 -3.3968 5.3968 .514 9 .619

PHASE1 - PHASE2Pair 1
PHASE1 - PHASE3Pair 2
PHASE2 - PHASE3Pair 3

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)
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Two-Way Repeated Measures ANOVA (Both Within-Subjects Factors) 
--Example of Significant Interaction 
 

 Phase I Phase II Phase III 
Subject Day Night Day Night Day Night 

S1 30 40 10 20 10 10 
S2 30 40 20 20 20 40 
S3 40 30 20 30 30 20 
S4 50 40 40 50 40 40 
S5 10 20 10 30 10 20 
S6 30 40 10 20 10 10 
S7 30 40 20 20 20 40 
S8 40 30 20 30 30 20 
S9 50 40 40 50 40 40 
S10 10 20 10 30 10 20 
S11 30 40 10 20 10 10 
S12 30 40 20 20 20 40 
S13 40 30 20 30 30 20 
S14 50 40 40 50 40 40 
S15 10 20 10 30 10 20 
S16 30 40 10 20 10 10 
S17 30 40 20 20 20 40 
S18 40 30 20 30 30 20 
S19 50 40 40 50 40 40 
S20 10 20 10 30 10 20 
S21 30 40 10 20 10 10 
S22 30 40 20 20 20 40 
S23 40 30 20 30 30 20 
S24 50 40 40 50 40 40 
S25 10 20 10 30 10 20 
S26 30 40 10 20 10 10 
S27 30 40 20 20 20 40 
S28 40 30 20 30 30 20 
S29 50 40 40 50 40 40 
S30 10 20 10 30 10 20 
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: Phase 
             Number of Levels: 3 
              √ ADD 
             Within-Subject Factor Name: Time 
             Number of Levels: 2 
              √ ADD 
              √ Define 
              Within-Subjects Variables (PHASE, TIME): 
                         P1DAY(1,1) 
                         P1NIGHT(1,2) 
                         P2DAY(2,1) 
                         P2NIGHT(2,2) 
                         P3DAY(3,1) 
                         P3NIGHT(3,2) 
                √Options 
                         Display Means for: PHASE, TIME, PHASE*TIME 
                         √Estimates of Effect Size 
 
General Linear Model 

Within-Subjects Factors 
Measure:MEASURE_1 
PHASE TIME Dependent Variable 

 

1 1 P1DAY 
2 P1NIGHT 

2 1 P2DAY 
2 P2NIGHT 

3 1 P3DAY 
2 P3NIGHT 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

PHASE Pillai's Trace .523 15.374a 2.000 28.000 .000 .523
Wilks' Lambda .477 15.374a 2.000 28.000 .000 .523
Hotelling's Trace 1.098 15.374a 2.000 28.000 .000 .523
Roy's Largest Root 1.098 15.374a 2.000 28.000 .000 .523

TIME Pillai's Trace .427 21.581a 1.000 29.000 .000 .427
Wilks' Lambda .573 21.581a 1.000 29.000 .000 .427
Hotelling's Trace .744 21.581a 1.000 29.000 .000 .427
Roy's Largest Root .744 21.581a 1.000 29.000 .000 .427

PHASE * TIME Pillai's Trace .345 7.368a 2.000 28.000 .003 .345
Wilks' Lambda .655 7.368a 2.000 28.000 .003 .345
Hotelling's Trace .526 7.368a 2.000 28.000 .003 .345
Roy's Largest Root .526 7.368a 2.000 28.000 .003 .345

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: PHASE + TIME + PHASE * TIME 
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Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects Effect 

Mauchly's 
W 

Approx. Chi-
Square df Sig. 

Epsilona 
Greenhouse-

Geisser 
Huynh-
Feldt Lower-bound

dimension1 

PHASE .764 7.551 2 .023 .809 .850 .500
TIME 1.000 .000 0 . 1.000 1.000 1.000
PHASE * 
TIME 

.645 12.274 2 .002 .738 .768 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: PHASE + TIME + PHASE * TIME 

 
 

Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Sphericity Assumed 2920.000 2 1460.000 21.825 .000 .429
Greenhouse-Geisser 2920.000 1.618 1805.099 21.825 .000 .429
Huynh-Feldt 2920.000 1.699 1718.416 21.825 .000 .429
Lower-bound 2920.000 1.000 2920.000 21.825 .000 .429

Error(PHASE) Sphericity Assumed 3880.000 58 66.897    
Greenhouse-Geisser 3880.000 46.912 82.709    
Huynh-Feldt 3880.000 49.278 78.737    
Lower-bound 3880.000 29.000 133.793    

TIME Sphericity Assumed 1280.000 1 1280.000 21.581 .000 .427
Greenhouse-Geisser 1280.000 1.000 1280.000 21.581 .000 .427
Huynh-Feldt 1280.000 1.000 1280.000 21.581 .000 .427
Lower-bound 1280.000 1.000 1280.000 21.581 .000 .427

Error(TIME) Sphericity Assumed 1720.000 29 59.310    
Greenhouse-Geisser 1720.000 29.000 59.310    
Huynh-Feldt 1720.000 29.000 59.310    
Lower-bound 1720.000 29.000 59.310    

PHASE * TIME Sphericity Assumed 520.000 2 260.000 8.021 .001 .217
Greenhouse-Geisser 520.000 1.476 352.277 8.021 .003 .217
Huynh-Feldt 520.000 1.536 338.489 8.021 .002 .217
Lower-bound 520.000 1.000 520.000 8.021 .008 .217

Error(PHASE*TIME) Sphericity Assumed 1880.000 58 32.414    
Greenhouse-Geisser 1880.000 42.807 43.918    
Huynh-Feldt 1880.000 44.551 42.199    
Lower-bound 1880.000 29.000 64.828    
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Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source    TIME Type III 

Sum of 
Squares df 

Mean 
Square F Sig. 

Partial Eta 
Squared 

PHASE  Linear   2430.000 1 2430.000 31.743 .000 .523
 Quadratic   490.000 1 490.000 8.560 .007 .228

Error(PHASE)  Linear   2220.000 29 76.552    
 Quadratic   1660.000 29 57.241    

TIME   dimension3 Linear 1280.000 1 1280.000 21.581 .000 .427
Error(TIME)   dimension3 Linear 1720.000 29 59.310    
PHASE * TIME  Linear  Linear 30.000 1 30.000 2.071 .161 .067

 Quadratic  Linear 490.000 1 490.000 9.733 .004 .251
Error(PHASE*TIME)  Linear  Linear 420.000 29 14.483    

 Quadratic  Linear 1460.000 29 50.345    
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 134480.000 1 134480.000 254.564 .000 .898
Error 15320.000 29 528.276    

 
Estimated Marginal Means 
 

1. PHASE
Measure:MEASURE_1 
PHASE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 
1 33.000 1.819 29.279 36.721
2 25.000 1.948 21.017 28.983
3 24.000 1.983 19.945 28.055

 
2. TIME 

Measure:MEASURE_1 
TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 24.667 2.130 20.311 29.023
2 30.000 1.412 27.113 32.887

 
3. PHASE * TIME

Measure:MEASURE_1 
PHASE TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 

1 1 32.000 2.464 26.962 37.038
2 34.000 1.486 30.962 37.038

2 1 20.000 2.034 15.840 24.160
2 30.000 2.034 25.840 34.160

3 1 22.000 2.166 17.571 26.429
2 26.000 2.228 21.443 30.557
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Follow-up Tests When the Interaction is Significant 
 
SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: Phase 
             Number of Levels: 3 
              √ ADD 
              √ Define 
              Within-Subjects Variables (PHASE): 
                         P1DAY(1) 
                         P2DAY(2) 
                         P3DAY(3) 
                √Options 
                         Display Means for: PHASE 
                         √Estimates of Effect Size 
 
General Linear Model 
 

Within-Subjects Factors
Measure:MEASURE_1 
PHASE Dependent Variable 

 
1 P1DAY 
2 P2DAY 
3 P3DAY 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

PHASE Pillai's Trace .733 38.500a 2.000 28.000 .000 .733
Wilks' Lambda .267 38.500a 2.000 28.000 .000 .733
Hotelling's Trace 2.750 38.500a 2.000 28.000 .000 .733
Roy's Largest Root 2.750 38.500a 2.000 28.000 .000 .733

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: PHASE 

 
 

Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 PHASE .612 13.737 2 .001 .721 .748 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: PHASE 

 
 
 
 



Multivariate Two-Way RM ANOVA, 18 

Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Sphericity Assumed 2480.000 2 1240.000 64.214 .000 .689
Greenhouse-Geisser 2480.000 1.441 1720.816 64.214 .000 .689
Huynh-Feldt 2480.000 1.496 1657.461 64.214 .000 .689
Lower-bound 2480.000 1.000 2480.000 64.214 .000 .689

Error(PHASE) Sphericity Assumed 1120.000 58 19.310    
Greenhouse-Geisser 1120.000 41.794 26.798    
Huynh-Feldt 1120.000 43.392 25.811    
Lower-bound 1120.000 29.000 38.621    

 
Tests of Within-Subjects Contrasts

Measure:MEASURE_1 
Source PHASE Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Linear 1500.000 1 1500.000 72.500 .000 .714
Quadratic 980.000 1 980.000 54.654 .000 .653

Error(PHASE) Linear 600.000 29 20.690    
Quadratic 520.000 29 17.931    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 54760.000 1 54760.000 134.125 .000 .822
Error 11840.000 29 408.276    

 
Estimated Marginal Means 
 

PHASE
Measure:MEASURE_1 
PHASE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 
1 32.000 2.464 26.962 37.038
2 20.000 2.034 15.840 24.160
3 22.000 2.166 17.571 26.429
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SPSS Instructions 
→ Analyze →Compare Means →Paired Samples T Test 
           Paired Variables: 
               Pair 1: P1DAY   P2DAY 
               Pair 2: P1DAY   P3DAY 
               Pair 3: P2DAY   P3DAY  
 
T-Test 

Paired Samples Statistics

 Mean N Std. Deviation Std. Error Mean 

Pair 1 P1DAY 32.0000 30 13.49329 2.46353 

P2DAY 20.0000 30 11.14172 2.03419 

Pair 2 P1DAY 32.0000 30 13.49329 2.46353 

P3DAY 22.0000 30 11.86127 2.16556 

Pair 3 P2DAY 20.0000 30 11.14172 2.03419 

P3DAY 22.0000 30 11.86127 2.16556 

Paired Samples Correlations

 N Correlation Sig. 

Pair 1 P1DAY & P2DAY 30 .826 .000

Pair 2 P1DAY & P3DAY 30 .879 .000

Pair 3 P2DAY & P3DAY 30 .939 .000

 

Paired Samples Test

 

Paired Differences 

t df 

Sig. (2-

tailed) Mean 

Std. 

Deviation 

Std. Error 

Mean 

95% Confidence Interval of 

the Difference 

Lower Upper 

Pair 1 P1DAY - 

P2DAY 

12.00000 7.61124 1.38962 9.15791 14.84209 8.635 29 .000

Pair 2 P1DAY - 

P3DAY 

10.00000 6.43268 1.17444 7.59800 12.40200 8.515 29 .000

Pair 3 P2DAY - 

P3DAY 

-2.00000 4.06838 .74278 -3.51916 -.48084 -2.693 29 .012

 
 
 
 
 
  



Multivariate Two-Way RM ANOVA, 20 

SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: Phase 
             Number of Levels: 3 
              √ ADD 
              √ Define 
              Within-Subjects Variables (PHASE): 
                         P1NIGHT(1) 
                         P2NIGHT(2) 
                         P3NIGHT(3) 
                √Options 
                         Display Means for: PHASE 
                         √Estimates of Effect Size 
 
General Linear Model 
 

Within-Subjects Factors
Measure:MEASURE_1 
PHASE Dependent Variable 

 
1 P1NIGHT 
2 P2NIGHT 
3 P3NIGHT 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

PHASE Pillai's Trace .325 6.741a 2.000 28.000 .004 .325
Wilks' Lambda .675 6.741a 2.000 28.000 .004 .325
Hotelling's Trace .481 6.741a 2.000 28.000 .004 .325
Roy's Largest Root .481 6.741a 2.000 28.000 .004 .325

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: PHASE 

 
 

Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 PHASE .963 1.052 2 .591 .964 1.000 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: PHASE 
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Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Sphericity Assumed 960.000 2 480.000 6.000 .004 .171
Greenhouse-Geisser 960.000 1.929 497.693 6.000 .005 .171
Huynh-Feldt 960.000 2.000 480.000 6.000 .004 .171
Lower-bound 960.000 1.000 960.000 6.000 .021 .171

Error(PHASE) Sphericity Assumed 4640.000 58 80.000    
Greenhouse-Geisser 4640.000 55.938 82.949    
Huynh-Feldt 4640.000 58.000 80.000    
Lower-bound 4640.000 29.000 160.000    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source PHASE Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

PHASE Linear 960.000 1 960.000 13.647 .001 .320
Quadratic .000 1 .000 .000 1.000 .000

Error(PHASE) Linear 2040.000 29 70.345    
Quadratic 2600.000 29 89.655    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 81000.000 1 81000.000 451.731 .000 .940
Error 5200.000 29 179.310    

 
Estimated Marginal Means 
 

PHASE
Measure:MEASURE_1 
PHASE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 
1 34.000 1.486 30.962 37.038
2 30.000 2.034 25.840 34.160
3 26.000 2.228 21.443 30.557
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SPSS Instructions 
→ Analyze →Compare Means →Paired Samples T Test 
           Paired Variables: 
               Pair 1: P1NIGHT   P2NIGHT 
               Pair 2: P1NIGHT   P3NIGHT 
               Pair 3: P2NIGHT   P3NIGHT  
 
 
T-Test 

Paired Samples Statistics
 Mean N Std. Deviation Std. Error Mean 

Pair 1 P1NIGHT 34.0000 30 8.13676 1.48556 
P2NIGHT 30.0000 30 11.14172 2.03419 

Pair 2 P1NIGHT 34.0000 30 8.13676 1.48556 
P3NIGHT 26.0000 30 12.20514 2.22834 

Pair 3 P2NIGHT 30.0000 30 11.14172 2.03419 
P3NIGHT 26.0000 30 12.20514 2.22834 

 
 

Paired Samples Correlations
 N Correlation Sig. 

Pair 1 P1NIGHT & P2NIGHT 30 .000 1.000
Pair 2 P1NIGHT & P3NIGHT 30 .375 .041
Pair 3 P2NIGHT & P3NIGHT 30 .456 .011

 
 

Paired Samples Test

 

Paired Differences 

t df 
Sig.  

(2-tailed) Mean 
Std. 

Deviation 
Std. Error 

Mean 

95% Confidence Interval 
of the Difference 

Lower Upper 
Pair 
1 

P1NIGHT - 
P2NIGHT 

4.00000 13.79655 2.51889 -1.15172 9.15172 1.588 29 .123

Pair 
2 

P1NIGHT - 
P3NIGHT 

8.00000 11.86127 2.16556 3.57093 12.42907 3.694 29 .001

Pair 
3 

P2NIGHT - 
P3NIGHT 

4.00000 12.20514 2.22834 -.55748 8.55748 1.795 29 .083
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: TIME 
             Number of Levels: 2 
              √ ADD 
              √ Define 
              Within-Subjects Variables (TIME): 
                         P1DAY(1) 
                         P1NIGHT(2) 
                √Options 
                         Display Means for: TIME 
                         √Estimates of Effect Size 
 
 
General Linear Model 

Within-Subjects Factors 
Measure:MEASURE_1 
TIME Dependent Variable 
1 P1DAY 
2 P1NIGHT 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

TIME Pillai's Trace .040 1.208a 1.000 29.000 .281 .040
Wilks' Lambda .960 1.208a 1.000 29.000 .281 .040
Hotelling's Trace .042 1.208a 1.000 29.000 .281 .040
Roy's Largest Root .042 1.208a 1.000 29.000 .281 .040

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: TIME 

 
 

Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 TIME 1.000 .000 0 . 1.000 1.000 1.000

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: TIME 
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Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Sphericity Assumed 60.000 1 60.000 1.208 .281 .040
Greenhouse-Geisser 60.000 1.000 60.000 1.208 .281 .040
Huynh-Feldt 60.000 1.000 60.000 1.208 .281 .040
Lower-bound 60.000 1.000 60.000 1.208 .281 .040

Error(TIME) Sphericity Assumed 1440.000 29 49.655    
Greenhouse-Geisser 1440.000 29.000 49.655    
Huynh-Feldt 1440.000 29.000 49.655    
Lower-bound 1440.000 29.000 49.655    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source TIME Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Linear 60.000 1 60.000 1.208 .281 .040
Error(TIME) Linear 1440.000 29 49.655    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 65340.000 1 65340.000 328.969 .000 .919
Error 5760.000 29 198.621    

 
 
Estimated Marginal Means 
 
 

TIME 
Measure:MEASURE_1 
TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 32.000 2.464 26.962 37.038
2 34.000 1.486 30.962 37.038
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: TIME 
             Number of Levels: 2 
              √ ADD 
              √ Define 
              Within-Subjects Variables (TIME): 
                         P2DAY(1) 
                         P2NIGHT(2) 
                √Options 
                         Display Means for: TIME 
                         √Estimates of Effect Size 
 
General Linear Model 
 

Within-Subjects Factors 
Measure:MEASURE_1 
TIME Dependent Variable 
1 P2DAY 
2 P2NIGHT 

 
 

Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

TIME Pillai's Trace .714 72.500a 1.000 29.000 .000 .714
Wilks' Lambda .286 72.500a 1.000 29.000 .000 .714
Hotelling's Trace 2.500 72.500a 1.000 29.000 .000 .714
Roy's Largest Root 2.500 72.500a 1.000 29.000 .000 .714

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: TIME 

 
 

Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 TIME 1.000 .000 0 . 1.000 1.000 1.000

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: TIME 
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Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Sphericity Assumed 1500.000 1 1500.000 72.500 .000 .714
Greenhouse-Geisser 1500.000 1.000 1500.000 72.500 .000 .714
Huynh-Feldt 1500.000 1.000 1500.000 72.500 .000 .714
Lower-bound 1500.000 1.000 1500.000 72.500 .000 .714

Error(TIME) Sphericity Assumed 600.000 29 20.690    
Greenhouse-Geisser 600.000 29.000 20.690    
Huynh-Feldt 600.000 29.000 20.690    
Lower-bound 600.000 29.000 20.690    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source TIME Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Linear 1500.000 1 1500.000 72.500 .000 .714
Error(TIME) Linear 600.000 29 20.690    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 37500.000 1 37500.000 164.773 .000 .850
Error 6600.000 29 227.586    

 
 
Estimated Marginal Means 
 

TIME 
Measure:MEASURE_1 
TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 20.000 2.034 15.840 24.160
2 30.000 2.034 25.840 34.160
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: TIME 
             Number of Levels: 2 
              √ ADD 
              √ Define 
              Within-Subjects Variables (TIME): 
                         P3DAY(1) 
                         P3NIGHT(2) 
                √Options 
                         Display Means for: TIME 
                         √Estimates of Effect Size 
 
 
General Linear Model 
 

Within-Subjects Factors 
Measure:MEASURE_1 
TIME Dependent Variable 
1 P3DAY 
2 P3NIGHT 

 
Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

TIME Pillai's Trace .133 4.462a 1.000 29.000 .043 .133
Wilks' Lambda .867 4.462a 1.000 29.000 .043 .133
Hotelling's Trace .154 4.462a 1.000 29.000 .043 .133
Roy's Largest Root .154 4.462a 1.000 29.000 .043 .133

a. Exact statistic 
b. Design: Intercept  
 Within Subjects Design: TIME 

 
Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 TIME 1.000 .000 0 . 1.000 1.000 1.000

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept  
 Within Subjects Design: TIME 
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Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Sphericity Assumed 240.000 1 240.000 4.462 .043 .133
Greenhouse-Geisser 240.000 1.000 240.000 4.462 .043 .133
Huynh-Feldt 240.000 1.000 240.000 4.462 .043 .133
Lower-bound 240.000 1.000 240.000 4.462 .043 .133

Error(TIME) Sphericity Assumed 1560.000 29 53.793    
Greenhouse-Geisser 1560.000 29.000 53.793    
Huynh-Feldt 1560.000 29.000 53.793    
Lower-bound 1560.000 29.000 53.793    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source TIME Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

TIME Linear 240.000 1 240.000 4.462 .043 .133
Error(TIME) Linear 1560.000 29 53.793    

 
Tests of Between-Subjects Effects

Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 34560.000 1 34560.000 146.526 .000 .835
Error 6840.000 29 235.862    

 
Estimated Marginal Means 
 

TIME 
Measure:MEASURE_1 
TIME 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 22.000 2.166 17.571 26.429
2 26.000 2.228 21.443 30.557
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One Factor Repeated, One Factor Between Subjects 
 
A Factor: Gender 
B Factor: Grade Level 
Dependent Variable: Number of Questions per Week with Teachers 
 
Number of Questions Per Week with Teachers 

Gender Subject First Grade Fourth Grade Seventh Grade 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 
Female 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

4.00 
3.00 
2.00 
7.00 
3.00 
4.00 
2.00 
5.00 
4.00 
6.00 
6.00 
5.00 
4.00 
3.00 
6.00 

2.00 
3.00 
2.00 
6.00 
10.00 
6.00 
3.00 
8.00 
11.00 
12.00 
4.00 
4.00 
5.00 
8.00 
7.00 

5.00 
6.00 
10.00 
8.00 
6.00 
4.00 
14.00 
10.00 
11.00 
12.00 
13.00 
11.00 
12.00 
9.00 
15.00 

Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 
Male 

16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 

5.00 
4.00 
6.00 
5.00 
12.00 
1.00 
7.00 
6.00 
5.00 
5.00 
3.00 
5.00 
3.00 
7.00 
3.00 

7.00 
2.00 
10.00 
8.00 
7.00 
5.00 
9.00 
3.00 
1.00 
6.00 
7.00 
7.00 
8.00 
12.00 
5.00 

16.00 
10.00 
12.00 
9.00 
12.00 
10.00 
6.00 
16.00 
7.00 
12.00 
6.00 
15.00 
15.00 
7.00 
12.00 
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: GRADE 
             Number of Levels: 3 
              √ ADD 
              √ Define 
              Within-Subjects Variables (GRADE): 
                         FIRST(1) 
                         FOURTH(2) 
                         SEVENTH(3) 
              Between-Subjects Variables: 
                         GENDER 
                √Options 
                         Display Means for: GRADE    GENDER     GRADE*GENDER 
                         √Estimates of Effect Size 
 
 
General Linear Model 
 

Within-Subjects Factors 
Measure:MEASURE_1 
GRADE Dependent Variable 

 
1 first 
2 fourth 
3 seventh 

 
 

Between-Subjects Factors 
 Value Label N 

gender 1.00 Female 15
2.00 Male 15

 
 

Multivariate Testsb

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

GRADE Pillai's Trace .705 32.250a 2.000 27.000 .000 .705
Wilks' Lambda .295 32.250a 2.000 27.000 .000 .705
Hotelling's Trace 2.389 32.250a 2.000 27.000 .000 .705
Roy's Largest Root 2.389 32.250a 2.000 27.000 .000 .705

GRADE * gender Pillai's Trace .010 .134a 2.000 27.000 .875 .010
Wilks' Lambda .990 .134a 2.000 27.000 .875 .010
Hotelling's Trace .010 .134a 2.000 27.000 .875 .010
Roy's Largest Root .010 .134a 2.000 27.000 .875 .010

a. Exact statistic 
b. Design: Intercept + gender  
 Within Subjects Design: GRADE 
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Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 GRADE .824 5.230 2 .073 .850 .932 .500
Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept + gender  
 Within Subjects Design: GRADE 

 
 

Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

GRADE Sphericity Assumed 513.756 2 256.878 32.987 .000 .541
Greenhouse-Geisser 513.756 1.701 302.117 32.987 .000 .541
Huynh-Feldt 513.756 1.864 275.658 32.987 .000 .541
Lower-bound 513.756 1.000 513.756 32.987 .000 .541

GRADE * 
gender 

Sphericity Assumed 2.822 2 1.411 .181 .835 .006
Greenhouse-Geisser 2.822 1.701 1.660 .181 .800 .006
Huynh-Feldt 2.822 1.864 1.514 .181 .820 .006
Lower-bound 2.822 1.000 2.822 .181 .674 .006

Error(GRADE) Sphericity Assumed 436.089 56 7.787    
Greenhouse-Geisser 436.089 47.615 9.159    
Huynh-Feldt 436.089 52.185 8.357    
Lower-bound 436.089 28.000 15.575    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source GRADE Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

GRADE Linear 481.667 1 481.667 64.612 .000 .698
Quadratic 32.089 1 32.089 3.952 .057 .124

GRADE * gender Linear .600 1 .600 .080 .779 .003
Quadratic 2.222 1 2.222 .274 .605 .010

Error(GRADE) Linear 208.733 28 7.455    
Quadratic 227.356 28 8.120    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 4551.111 1 4551.111 451.599 .000 .942
gender 16.044 1 16.044 1.592 .217 .054
Error 282.178 28 10.078    
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Estimated Marginal Means 
 
 
 

1. gender
Measure:MEASURE_1 
gender 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
Female 6.689 .473 5.720 7.658
Male 7.533 .473 6.564 8.503

 
 

2. GRADE
Measure:MEASURE_1 
GRADE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 

 
1 4.700 .379 3.924 5.476
2 6.267 .563 5.113 7.421
3 10.367 .628 9.081 11.652

 
 

3. gender * GRADE
Measure:MEASURE_1 
gender GRADE 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
Female 

 
1 4.267 .536 3.169 5.365 
2 6.067 .797 4.434 7.699 
3 9.733 .888 7.915 11.552 

Male 
 

1 5.133 .536 4.035 6.231 
2 6.467 .797 4.834 8.099 
3 11.000 .888 9.182 12.818 

 
 
Follow-up Tests When the Interaction Is NOT Significant… 
 
 
Pairwise Comparisons for the Between-Subjects Factor 
 
The easiest way to obtain these comparisons is to rerun the original analysis and select the Tukey 
procedure.  
 
 
Pairwise Comparisons for the Within-Subjects Factor 

• Use the t test for dependent samples to conduct the pairwise comparisons.  
• Use a Bonferroni or Sidak adjusted alpha level to determine the significance of the t tests. 
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SPSS Instructions 
→ Analyze →Compare Means →Paired Samples T Test 
           Paired Variables: 
               Pair 1: FIRST   FOURTH 
               Pair 2: FIRST   SEVENTH  
               Pair 3: FOURTH   SEVENTH  
 

T-Test 

 

 

 
 

Paired Samples Statistics

4.7000 30 2.08690 .38101
6.2667 30 3.03921 .55488
4.7000 30 2.08690 .38101

10.3667 30 3.43896 .62787
6.2667 30 3.03921 .55488

10.3667 30 3.43896 .62787

FIRST
FOURTH

Pair
1

FIRST
SEVENTH

Pair
2

FOURTH
SEVENTH

Pair
3

Mean N Std. Deviation
Std. Error

Mean

Paired Samples Correlations

30 .285 .127
30 .122 .522
30 .004 .985

FIRST & FOURTHPair 1
FIRST & SEVENTHPair 2
FOURTH & SEVENTHPair 3

N Correlation Sig.

Paired Samples Test

-1.5667 3.15882 .57672 -2.7462 -.3871 -2.717 29 .011
-5.6667 3.79958 .69370 -7.0855 -4.2479 -8.169 29 .000
-4.1000 4.58145 .83645 -5.8107 -2.3893 -4.902 29 .000

FIRST - FOURTHPair 1
FIRST - SEVENTHPair 2
FOURTH - SEVENTHPair 3

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df
Sig.

(2-tailed)



Multivariate Two-Way RM ANOVA, 34 

A Factor: Type of club 
B Factor: School status 
Dependent Variable: GPA for current status 
 

 Subject Freshman GPA Sophomore GPA Junior GPA Senior GPA 
Social 
Clubs 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 

3.01 
2.83 
2.52 
1.97 
2.61 
2.91 
1.46 
2.29 
1.63 
1.90 
1.16 
1.13 
1.74 

2.08 
2.35 
1.90 
2.12 
1.97 
2.31 
2.44 
2.66 
1.95 
2.10 
2.24 
1.95 
2.49 

3.24 
2.38 
2.44 
2.88 
2.22 
3.23 
3.16 
2.43 
2.30 
2.80 
2.55 
1.90 
2.69 

2.90 
2.64 
3.20 
2.93 
3.07 
2.83 
3.32 
2.98 
2.82 
3.01 
2.81 
3.09 
3.32 

Sports 
Clubs 

14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 

2.19 
2.24 
2.24 
2.18 
1.68 
2.21 
2.50 
2.21 
2.25 
1.79 
2.14 
2.17 
2.97 
2.51 
2.33 

2.02 
2.29 
2.05 
2.33 
2.22 
2.33 
2.26 
1.97 
2.89 
2.04 
2.16 
1.97 
2.07 
2.18 
2.04 

3.15 
2.81 
2.84 
3.24 
2.21 
2.12 
3.07 
2.58 
3.02 
2.25 
2.79 
2.31 
2.60 
1.87 
1.92 

2.74 
3.22 
3.32 
3.26 
2.78 
3.17 
2.96 
2.96 
2.99 
3.05 
2.85 
2.86 
2.76 
2.56 
3.11 

Academic 
Clubs 

29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
41 
42 
43 

3.08 
3.03 
3.10 
2.48 
3.01 
2.87 
3.04 
2.58 
3.24 
2.77 
3.10 
2.99 
3.10 
3.63 
2.85 

2.83 
3.12 
3.24 
3.01 
3.39 
2.54 
2.98 
2.70 
3.17 
3.03 
3.19 
2.99 
3.00 
3.54 
3.05 

2.82 
2.74 
3.32 
3.17 
2.95 
2.87 
2.66 
3.53 
3.08 
3.27 
3.39 
2.82 
2.79 
2.96 
2.90 

2.25 
2.56 
2.69 
2.71 
2.83 
3.14 
2.98 
2.90 
3.27 
3.13 
3.12 
3.07 
3.19 
2.50 
3.08 
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SPSS Instructions 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: YEAR 
             Number of Levels: 4 
              √ ADD 
              √ Define 
              Within-Subjects Variables (YEAR): 
                         FRESHGPA(1) 
                         SOPHGPA(2) 
                         JRGPA(3) 
                         SRGPA(4) 
              Between-Subjects Variables: 
                         CLUB 
                √Options 
                         Display Means for: YEAR    CLUB     YEAR*CLUB 
                         √Estimates of Effect Size 
 
 
General Linear Model 
 

Within-Subjects Factors 
Measure:MEASURE_1 
YEAR Dependent Variable 
1 freshgpa 
2 sophgpa 
3 jrgpa 
4 srgpa 

 
Between-Subjects Factors 

 Value Label N 
club 1.00 social clubs 13

2.00 sports clubs 15
3.00 academic clubs 15

 
 

Multivariate Testsc

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

YEAR Pillai's Trace .679 26.855a 3.000 38.000 .000 .679
Wilks' Lambda .321 26.855a 3.000 38.000 .000 .679
Hotelling's Trace 2.120 26.855a 3.000 38.000 .000 .679
Roy's Largest Root 2.120 26.855a 3.000 38.000 .000 .679

YEAR * club Pillai's Trace .673 6.590 6.000 78.000 .000 .336
Wilks' Lambda .344 8.938a 6.000 76.000 .000 .414
Hotelling's Trace 1.861 11.477 6.000 74.000 .000 .482
Roy's Largest Root 1.835 23.854b 3.000 39.000 .000 .647

a. Exact statistic 
b. The statistic is an upper bound on F that yields a lower bound on the significance level. 
c. Design: Intercept + club  
 Within Subjects Design: YEAR 
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Mauchly's Test of Sphericityb

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 YEAR .745 11.410 5 .044 .842 .948 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. Design: Intercept + club  
 Within Subjects Design: YEAR 

 
 

Tests of Within-Subjects Effects
Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

YEAR Sphericity Assumed 7.445 3 2.482 23.855 .000 .374
Greenhouse-Geisser 7.445 2.525 2.948 23.855 .000 .374
Huynh-Feldt 7.445 2.844 2.618 23.855 .000 .374
Lower-bound 7.445 1.000 7.445 23.855 .000 .374

YEAR * club Sphericity Assumed 5.875 6 .979 9.411 .000 .320
Greenhouse-Geisser 5.875 5.050 1.163 9.411 .000 .320
Huynh-Feldt 5.875 5.688 1.033 9.411 .000 .320
Lower-bound 5.875 2.000 2.937 9.411 .000 .320

Error(YEAR) Sphericity Assumed 12.485 120 .104    
Greenhouse-Geisser 12.485 101.007 .124    
Huynh-Feldt 12.485 113.765 .110    
Lower-bound 12.485 40.000 .312    

 
 

Tests of Within-Subjects Contrasts
Measure:MEASURE_1 
Source YEAR Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

YEAR Linear 6.966 1 6.966 49.392 .000 .553
Quadratic .309 1 .309 3.580 .066 .082
Cubic .170 1 .170 2.012 .164 .048

YEAR * club Linear 5.016 2 2.508 17.785 .000 .471
Quadratic .765 2 .383 4.428 .018 .181
Cubic .093 2 .047 .550 .581 .027

Error(YEAR) Linear 5.641 40 .141    
Quadratic 3.456 40 .086    
Cubic 3.387 40 .085    

 
 

Tests of Between-Subjects Effects
Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 1206.676 1 1206.676 8817.349 .000 .995
club 9.805 2 4.902 35.822 .000 .642
Error 5.474 40 .137    
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Estimated Marginal Means 
 
 

1. club
Measure:MEASURE_1 
club 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
social clubs 2.478 .051 2.375 2.582
sports clubs 2.497 .048 2.400 2.593
academic clubs 2.989 .048 2.892 3.085

 
 2. YEAR
 Measure:MEASURE_1 
 YEAR 

Mean Std. Error 
95% Confidence Interval 

 Lower Bound Upper Bound 

 

1 2.441 .066 2.308 2.574
2 2.480 .037 2.405 2.554
3 2.745 .058 2.627 2.863
4 2.954 .037 2.878 3.029

 
 
 3. club * YEAR
 Measure:MEASURE_1 
 club YEAR 

Mean Std. Error 
95% Confidence Interval 

 Lower Bound Upper Bound 
social clubs 1 2.089 .119 1.849 2.330

2 2.198 .067 2.063 2.333
3 2.632 .106 2.418 2.846
4 2.994 .068 2.856 3.131

sports clubs 1 2.241 .111 2.017 2.466
2 2.189 .062 2.063 2.315
3 2.584 .099 2.385 2.784
4 2.973 .063 2.845 3.100

academic clubs 1 2.991 .111 2.767 3.216
2 3.052 .062 2.926 3.177
3 3.018 .099 2.818 3.217
4 2.895 .063 2.767 3.023
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SPSS Instructions 
→Analyze→Compare Means→One-Way ANOVA 
 Dependent List: FRESHGPA     SOPHGPA    JRGPA      SRGPA 
 Factor: CLUB 

→Options 
 √ Descriptives 
            √ Welch 
 
→Post Hoc 
             √Games-Howell 
              Significance Level: .0125 

 
Oneway 

 

 

Descriptives

13 2.0895 .65502 .18167 1.6936 2.4853 1.13 3.01
15 2.2415 .29373 .07584 2.0788 2.4042 1.68 2.97
15 2.9912 .27179 .07018 2.8407 3.1417 2.48 3.63
43 2.4571 .57991 .08844 2.2786 2.6355 1.13 3.63
13 2.1982 .23975 .06650 2.0533 2.3431 1.90 2.66
15 2.1890 .23127 .05971 2.0610 2.3171 1.97 2.89
15 3.0518 .25076 .06475 2.9130 3.1907 2.54 3.54
43 2.4928 .47606 .07260 2.3463 2.6393 1.90 3.54
13 2.6321 .41480 .11504 2.3815 2.8828 1.90 3.24
15 2.5843 .44926 .11600 2.3355 2.8331 1.87 3.24
15 3.0178 .26135 .06748 2.8731 3.1625 2.66 3.53
43 2.7500 .42300 .06451 2.6198 2.8802 1.87 3.53
13 2.9936 .20435 .05668 2.8701 3.1171 2.64 3.32
15 2.9726 .21733 .05611 2.8522 3.0930 2.56 3.32
15 2.8950 .29762 .07685 2.7302 3.0598 2.25 3.27
43 2.9519 .24300 .03706 2.8771 3.0267 2.25 3.32

social clubs
sports clubs
academic clubs
Total
social clubs
sports clubs
academic clubs
Total
social clubs
sports clubs
academic clubs
Total
social clubs
sports clubs
academic clubs
Total

FRESHGPA

SOPHGPA

JRGPA

SRGPA

N Mean Std. Deviation Std. Error Lower Bound Upper Bound

95% Confidence Interval for
Mean

Minimum Maximum

ANOVA

6.734 2 3.367 18.223 .000
7.391 40 .185

14.124 42
7.200 2 3.600 62.098 .000
2.319 40 .058
9.519 42
1.668 2 .834 5.707 .007
5.847 40 .146
7.515 42

.078 2 .039 .645 .530
2.402 40 .060
2.480 42

Between Groups
Within Groups
Total
Between Groups
Within Groups
Total
Between Groups
Within Groups
Total
Between Groups
Within Groups
Total

FRESHGPA

SOPHGPA

JRGPA

SRGPA

Sum of
Squares df Mean Square F Sig.
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Post Hoc Tests 

 

Robust Tests of Equality of Means

29.818 2 23.640 .000
58.322 2 26.345 .000

7.307 2 24.227 .003
.537 2 26.339 .591

Welch
Welch
Welch
Welch

FRESHGPA
SOPHGPA
JRGPA
SRGPA

Statistica df1 df2 Sig.

Asymptotically F distributed.a. 

Multiple Comparisons

Games-Howell

-.1520 .19686 .725 -.7960 .4920
-.9018* .19475 .001 -1.5423 -.2612
.1520 .19686 .725 -.4920 .7960

-.7497* .10333 .000 -1.0678 -.4317
.9018* .19475 .001 .2612 1.5423
.7497* .10333 .000 .4317 1.0678
.0092 .08937 .994 -.2684 .2867

-.8536* .09281 .000 -1.1412 -.5660
-.0092 .08937 .994 -.2867 .2684
-.8628* .08808 .000 -1.1339 -.5916
.8536* .09281 .000 .5660 1.1412
.8628* .08808 .000 .5916 1.1339
.0479 .16337 .954 -.4582 .5539

-.3857 .13338 .024 -.8106 .0393
-.0479 .16337 .954 -.5539 .4582
-.4335* .13420 .010 -.8548 -.0122
.3857 .13338 .024 -.0393 .8106
.4335* .13420 .010 .0122 .8548
.0210 .07976 .963 -.2261 .2681
.0985 .09549 .564 -.1984 .3954

-.0210 .07976 .963 -.2681 .2261
.0776 .09515 .697 -.2174 .3726

-.0985 .09549 .564 -.3954 .1984
-.0776 .09515 .697 -.3726 .2174

(J) CLUB
sports clubs
academic clubs
social clubs
academic clubs
social clubs
sports clubs
sports clubs
academic clubs
social clubs
academic clubs
social clubs
sports clubs
sports clubs
academic clubs
social clubs
academic clubs
social clubs
sports clubs
sports clubs
academic clubs
social clubs
academic clubs
social clubs
sports clubs

(I) CLUB
social clubs

sports clubs

academic clubs

social clubs

sports clubs

academic clubs

social clubs

sports clubs

academic clubs

social clubs

sports clubs

academic clubs

Dependent Variable
FRESHGPA

SOPHGPA

JRGPA

SRGPA

Mean
Difference

(I-J) Std. Error Sig. Lower Bound Upper Bound
98.75% Confidence Interval

The mean difference is significant at the .0125 level.*. 
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SPSS Instructions 
→Data→Split File 
   √ Organize Output by Groups 
 Groups based on: CLUB 
→Analyze→General Linear Model→Repeated Measures 
             Within-Subject Factor Name: YEAR 
             Number of Levels: 4 
              √ ADD 
              √ Define 
              Within-Subjects Variables (YEAR): 
                        FRESHGPA(1) 
  SOPHGPA(2) 
  JRGPA(3) 
  SRGPA(4) 
                √Options 
                         Display Means for: YEAR 
                         √Estimates of Effect Size 
 
 
General Linear Model 
 

Within-Subjects Factors 
Measure:MEASURE_1 
year Dependent Variable 
1 freshgpa 
2 sophgpa 
3 jrgpa 
4 srgpa 

 
club = social clubs 
 

Between-Subjects Factorsa 
 

a. club = social clubs 
 

Multivariate Testsb,c

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

year Pillai's Trace .889 26.631a 3.000 10.000 .000 .889
Wilks' Lambda .111 26.631a 3.000 10.000 .000 .889
Hotelling's Trace 7.989 26.631a 3.000 10.000 .000 .889
Roy's Largest Root 7.989 26.631a 3.000 10.000 .000 .889

a. Exact statistic 
b. club = social clubs 
c. Design: Intercept  
 Within Subjects Design: year 
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Mauchly's Test of Sphericityb,c

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 year .358 11.000 5 .052 .615 .722 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. club = social clubs 
c. Design: Intercept  
 Within Subjects Design: year 

 
 

Tests of Within-Subjects Effectsa

Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Sphericity Assumed 6.745 3 2.248 13.972 .000 .538
Greenhouse-Geisser 6.745 1.846 3.654 13.972 .000 .538
Huynh-Feldt 6.745 2.166 3.114 13.972 .000 .538
Lower-bound 6.745 1.000 6.745 13.972 .003 .538

Error(year) Sphericity Assumed 5.793 36 .161    
Greenhouse-Geisser 5.793 22.149 .262    
Huynh-Feldt 5.793 25.992 .223    
Lower-bound 5.793 12.000 .483    

a. club = social clubs 
 
 

Tests of Within-Subjects Contrastsa

Measure:MEASURE_1 
Source year Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Linear 6.434 1 6.434 27.496 .000 .696
Quadratic .207 1 .207 1.714 .215 .125
Cubic .103 1 .103 .805 .387 .063

Error(year) Linear 2.808 12 .234    
Quadratic 1.452 12 .121    
Cubic 1.532 12 .128    

a. club = social clubs 
 
 

Tests of Between-Subjects Effectsa

Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 319.393 1 319.393 1467.636 .000 .992
Error 2.611 12 .218    
a. club = social clubs 
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Estimated Marginal Means 
 
 

yeara 
Measure:MEASURE_1 
year 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 2.089 .182 1.694 2.485
2 2.198 .066 2.053 2.343
3 2.632 .115 2.381 2.883
4 2.994 .057 2.870 3.117
a. club = social clubs 

 
 
club = sports clubs 
 

Between-Subjects 
Factorsa 

 
a. club = sports clubs 

 
 

Multivariate Testsb,c

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

year Pillai's Trace .894 33.585a 3.000 12.000 .000 .894
Wilks' Lambda .106 33.585a 3.000 12.000 .000 .894
Hotelling's Trace 8.396 33.585a 3.000 12.000 .000 .894
Roy's Largest Root 8.396 33.585a 3.000 12.000 .000 .894

a. Exact statistic 
b. club = sports clubs 
c. Design: Intercept  
 Within Subjects Design: year 

 
 

Mauchly's Test of Sphericityb,c

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 year .716 4.250 5 .515 .833 1.000 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. club = sports clubs 
c. Design: Intercept  
 Within Subjects Design: year 
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Tests of Within-Subjects Effectsa

Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Sphericity Assumed 5.909 3 1.970 22.921 .000 .621
Greenhouse-Geisser 5.909 2.498 2.365 22.921 .000 .621
Huynh-Feldt 5.909 3.000 1.970 22.921 .000 .621
Lower-bound 5.909 1.000 5.909 22.921 .000 .621

Error(year) Sphericity Assumed 3.609 42 .086    
Greenhouse-Geisser 3.609 34.978 .103    
Huynh-Feldt 3.609 42.000 .086    
Lower-bound 3.609 14.000 .258    

a. club = sports clubs 
 
 

Tests of Within-Subjects Contrastsa

Measure:MEASURE_1 
Source year Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Linear 5.026 1 5.026 61.317 .000 .814
Quadratic .729 1 .729 8.766 .010 .385
Cubic .155 1 .155 1.671 .217 .107

Error(year) Linear 1.147 14 .082    
Quadratic 1.164 14 .083    
Cubic 1.298 14 .093    

a. club = sports clubs 
 
 

Tests of Between-Subjects Effectsa

Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 374.057 1 374.057 2854.700 .000 .995
Error 1.834 14 .131    
a. club = sports clubs 

 
 
Estimated Marginal Means 
 
 

yeara 
Measure:MEASURE_1 
year 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 2.241 .076 2.079 2.404
2 2.189 .060 2.061 2.317
3 2.584 .116 2.335 2.833
4 2.973 .056 2.852 3.093
a. club = sports clubs 
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club = academic clubs 
 
 
 

Between-Subjects Factorsa 
 

a. club = academic clubs 
 
 

Multivariate Testsb,c

Effect 
Value F Hypothesis df Error df Sig. 

Partial Eta 
Squared 

year Pillai's Trace .163 .778a 3.000 12.000 .529 .163
Wilks' Lambda .837 .778a 3.000 12.000 .529 .163
Hotelling's Trace .194 .778a 3.000 12.000 .529 .163
Roy's Largest Root .194 .778a 3.000 12.000 .529 .163

a. Exact statistic 
b. club = academic clubs 
c. Design: Intercept  
 Within Subjects Design: year 

 
 

Mauchly's Test of Sphericityb,c

Measure:MEASURE_1 
Within Subjects 
Effect 

Mauchly's W 
Approx. Chi-

Square df Sig. 

Epsilona 
Greenhouse-

Geisser Huynh-Feldt Lower-bound 
dimension1 year .466 9.710 5 .085 .732 .874 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is 
proportional to an identity matrix. 
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the Tests 
of Within-Subjects Effects table. 
b. club = academic clubs 
c. Design: Intercept  
 Within Subjects Design: year 

 
 

Tests of Within-Subjects Effectsa

Measure:MEASURE_1 
Source Type III Sum 

of Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Sphericity Assumed .204 3 .068 .927 .436 .062
Greenhouse-Geisser .204 2.196 .093 .927 .414 .062
Huynh-Feldt .204 2.621 .078 .927 .427 .062
Lower-bound .204 1.000 .204 .927 .352 .062

Error(year) Sphericity Assumed 3.083 42 .073    
Greenhouse-Geisser 3.083 30.739 .100    
Huynh-Feldt 3.083 36.689 .084    
Lower-bound 3.083 14.000 .220    

a. club = academic clubs 
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Tests of Within-Subjects Contrastsa

Measure:MEASURE_1 
Source year Type III Sum of 

Squares df Mean Square F Sig. 
Partial Eta 
Squared 

year Linear .078 1 .078 .649 .434 .044
Quadratic .126 1 .126 2.101 .169 .130
Cubic 2.590E-5 1 2.590E-5 .001 .980 .000

Error(year) Linear 1.686 14 .120    
Quadratic .840 14 .060    
Cubic .557 14 .040    

a. club = academic clubs 
 
 

Tests of Between-Subjects Effectsa

Measure:MEASURE_1 
Transformed Variable:Average 
Source Type III Sum of 

Squares df Mean Square F Sig. Partial Eta Squared 
Intercept 536.035 1 536.035 7298.916 .000 .998
Error 1.028 14 .073    
a. club = academic clubs 

 
 
Estimated Marginal Means 
 

yeara 
Measure:MEASURE_1 
year 

Mean Std. Error 
95% Confidence Interval 

Lower Bound Upper Bound 
1 2.991 .070 2.841 3.142
2 3.052 .065 2.913 3.191
3 3.018 .067 2.873 3.163
4 2.895 .077 2.730 3.060
a. club = academic clubs 
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SPSS Instructions 
→ Analyze →Compare Means →Paired Samples T Test 
           Paired Variables: 
               Pair 1: FRESHGPA   SOPHGPA 
               Pair 2: FRESHGPA   JRGPA 
               Pair 3: FRESHGPA   SRGPA 
              Pair 4: SOPHGPA   JRGPA 
    Pair 5: SOPHGPA   SRGPA 
    Pair 6: JRGPA   SRGPA 

 
T-Test 
CLUB = social clubs 

 

 

Paired Samples Statisticsa

2.0895 13 .65502 .18167
2.1982 13 .23975 .06650
2.0895 13 .65502 .18167
2.6321 13 .41480 .11504
2.0895 13 .65502 .18167
2.9936 13 .20435 .05668
2.1982 13 .23975 .06650
2.6321 13 .41480 .11504
2.1982 13 .23975 .06650
2.9936 13 .20435 .05668
2.6321 13 .41480 .11504
2.9936 13 .20435 .05668

FRESHGPA
SOPHGPA

Pair
1

FRESHGPA
JRGPA

Pair
2

FRESHGPA
SRGPA

Pair
3

SOPHGPA
JRGPA

Pair
4

SOPHGPA
SRGPA

Pair
5

JRGPA
SRGPA

Pair
6

Mean N Std. Deviation
Std. Error

Mean

CLUB = social clubsa. 

Paired Samples Correlationsa

13 .016 .958
13 .320 .286
13 -.325 .279
13 .321 .285
13 .069 .824
13 .043 .888

FRESHGPA & SOPHGPAPair 1
FRESHGPA & JRGPAPair 2
FRESHGPA & SRGPAPair 3
SOPHGPA & JRGPAPair 4
SOPHGPA & SRGPAPair 5
JRGPA & SRGPAPair 6

N Correlation Sig.

CLUB = social clubsa. 
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CLUB = sports clubs 

 

 

 

Paired Samples Testa

-.1087 .69384 .19244 -.5280 .3105 -.565 12 .582
-.5427 .65354 .18126 -.9376 -.1478 -2.994 12 .011
-.9041 .74679 .20712 -1.3554 -.4528 -4.365 12 .001
-.4339 .40704 .11289 -.6799 -.1880 -3.844 12 .002
-.7954 .30418 .08436 -.9792 -.6116 -9.428 12 .000
-.3614 .45438 .12602 -.6360 -.0868 -2.868 12 .014

FRESHGPA - SOPHGPAPair 1
FRESHGPA - JRGPAPair 2
FRESHGPA - SRGPAPair 3
SOPHGPA - JRGPAPair 4
SOPHGPA - SRGPAPair 5
JRGPA - SRGPAPair 6

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

CLUB = social clubsa. 

Paired Samples Statisticsa

2.2415 15 .29373 .07584
2.1890 15 .23127 .05971
2.2415 15 .29373 .07584
2.5843 15 .44926 .11600
2.2415 15 .29373 .07584
2.9726 15 .21733 .05611
2.1890 15 .23127 .05971
2.5843 15 .44926 .11600
2.1890 15 .23127 .05971
2.9726 15 .21733 .05611
2.5843 15 .44926 .11600
2.9726 15 .21733 .05611

FRESHGPA
SOPHGPA

Pair
1

FRESHGPA
JRGPA

Pair
2

FRESHGPA
SRGPA

Pair
3

SOPHGPA
JRGPA

Pair
4

SOPHGPA
SRGPA

Pair
5

JRGPA
SRGPA

Pair
6

Mean N Std. Deviation
Std. Error

Mean

CLUB = sports clubsa. 

Paired Samples Correlationsa

15 -.004 .989
15 .104 .713
15 -.194 .489
15 .309 .263
15 .165 .558
15 .269 .333

FRESHGPA & SOPHGPAPair 1
FRESHGPA & JRGPAPair 2
FRESHGPA & SRGPAPair 3
SOPHGPA & JRGPAPair 4
SOPHGPA & SRGPAPair 5
JRGPA & SRGPAPair 6

N Correlation Sig.

CLUB = sports clubsa. 

Paired Samples Testa

.0524 .37457 .09671 -.1550 .2599 .542 14 .596
-.3428 .51060 .13184 -.6256 -.0600 -2.600 14 .021
-.7311 .39780 .10271 -.9514 -.5108 -7.118 14 .000
-.3952 .43719 .11288 -.6373 -.1531 -3.501 14 .004
-.7836 .29012 .07491 -.9442 -.6229 -10.460 14 .000
-.3883 .44343 .11449 -.6339 -.1428 -3.392 14 .004

FRESHGPA - SOPHGPAPair 1
FRESHGPA - JRGPAPair 2
FRESHGPA - SRGPAPair 3
SOPHGPA - JRGPAPair 4
SOPHGPA - SRGPAPair 5
JRGPA - SRGPAPair 6

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

CLUB = sports clubsa. 
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CLUB = academic clubs 

 

 

 
 
 
 
SPSS Instructions 
→Data→Split File 
   √ Analyze all cases; do not create groups  
 
  
 

Paired Samples Statisticsa

2.9912 15 .27179 .07018
3.0518 15 .25076 .06475
2.9912 15 .27179 .07018
3.0178 15 .26135 .06748
2.9912 15 .27179 .07018
2.8950 15 .29762 .07685
3.0518 15 .25076 .06475
3.0178 15 .26135 .06748
3.0518 15 .25076 .06475
2.8950 15 .29762 .07685
3.0178 15 .26135 .06748
2.8950 15 .29762 .07685

FRESHGPA
SOPHGPA

Pair
1

FRESHGPA
JRGPA

Pair
2

FRESHGPA
SRGPA

Pair
3

SOPHGPA
JRGPA

Pair
4

SOPHGPA
SRGPA

Pair
5

JRGPA
SRGPA

Pair
6

Mean N Std. Deviation
Std. Error

Mean

CLUB = academic clubsa. 

Paired Samples Correlationsa

15 .624 .013
15 -.340 .215
15 -.182 .517
15 .021 .942
15 -.204 .467
15 .131 .641

FRESHGPA & SOPHGPAPair 1
FRESHGPA & JRGPAPair 2
FRESHGPA & SRGPAPair 3
SOPHGPA & JRGPAPair 4
SOPHGPA & SRGPAPair 5
JRGPA & SRGPAPair 6

N Correlation Sig.

CLUB = academic clubsa. 

Paired Samples Testa

-.0606 .22729 .05869 -.1865 .0653 -1.033 14 .319
-.0266 .43642 .11268 -.2682 .2151 -.236 14 .817
.0962 .43802 .11310 -.1464 .3388 .851 14 .409
.0340 .35846 .09255 -.1645 .2325 .368 14 .719
.1568 .42645 .11011 -.0794 .3930 1.424 14 .176
.1228 .36937 .09537 -.0818 .3273 1.287 14 .219

FRESHGPA - SOPHGPAPair 1
FRESHGPA - JRGPAPair 2
FRESHGPA - SRGPAPair 3
SOPHGPA - JRGPAPair 4
SOPHGPA - SRGPAPair 5
JRGPA - SRGPAPair 6

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

CLUB = academic clubsa. 


